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1. What does HTML stand for? 
A) High Text Machine Language 

B) Hyper Text and links Markup Language 

C) Hyper Text Markup Language 

D) None of these 

Answer: C) Hyper Text Markup Language 

 

2. Which HTML tag is used to define an internal 

style sheet? 

A) <style> 

B) <script> 

C) <css> 

D) <link> 

Answer: A) <style> 

 

3. Which tag is used to create a hyperlink in 

HTML? 

A) <a> 

B) <link> 

C) <href> 

D) <hyper> 

Answer: A) <a> 

 

4. Which HTML element is used for inserting a 

line break? 

A) <break> 

B) <lb> 

C) <br> 

D) <hr> 

Answer: C) <br> 

 

5. HTML files are saved by default with the 

extension? 

A) .ht 

B) .html 

C) .hml 

D) .txt 

Answer: B) .html 

 

6. Which tag is used to display a picture in a 

webpage? 

A) <img> 

B) <image> 

C) <pic> 

D) <src> 

Answer: A) <img> 

 

7. Which attribute is used with <img> tag to 

display text if the image is not loaded? 

A) title 

B) alt 

C) src 

D) value 

Answer: B) alt 

 

8. The correct HTML tag for the largest heading 

is: 

A) <head> 

B) <h6> 

C) <h1> 

D) <heading> 

Answer: C) <h1> 

 

9. Which tag is used to create a numbered list? 

A) <ul> 

B) <ol> 

C) <li> 

D) <list> 

Answer: B) <ol> 

 

10. Which tag is used to make text bold in 

HTML? 
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A) <bold> 

B) <b> 

C) <strong> 
D) Both B and C 

Answer: D) Both B and C 

 

11. What is the purpose of the <title> tag in 

HTML? 
A) To name the document 

B) To create heading 

C) To make bold text 

D) To set background color 

Answer: A) To name the document 

 

12. Which of the following tags is used to 

separate sections of text in HTML? 

A) <br> 

B) <p> 

C) <body> 

D) <break> 

Answer: B) <p> 

 

13. Which tag is used to define a table in HTML? 

A) <table> 

B) <td> 

C) <tr> 

D) <tab> 

Answer: A) <table> 

 

14. What does the <th> tag represent in HTML 

tables? 
A) Table row 

B) Table column 

C) Table header 

D) Table heading row 

Answer: C) Table header 

 

15. Which HTML attribute specifies an alternate 

text for an image, if the image cannot be 

displayed? 

A) alt 

B) title 

C) src 

D) longdesc 

Answer: A) alt 

 

16. The <hr> tag in HTML is used for: 

A) Horizontal line 

B) Heading rule 

C) Hard rule 

D) Hyperlink 

Answer: A) Horizontal line 

 

17. Which tag is used to add background color to 

an HTML element? 

A) color 

B) style 

C) background 

D) bgcolor 

Answer: D) bgcolor 

 

18. What is the correct HTML for creating a 

checkbox? 

A) <input type="checkbox"> 

B) <checkbox> 

C) <check> 

D) <input checkbox> 

Answer: A) <input type="checkbox"> 

 

19. What is the correct HTML for creating a 

drop-down list? 

A) <dropdown> 

B) <select> 

C) <list> 
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D) <option> 

Answer: B) <select> 

 

20. Which HTML tag is used to define an 

unordered list? 

A) <ol> 

B) <ul> 

C) <li> 

D) <list> 

Answer: B) <ul> 

 

21. HTML comments are written in this way: 

A) // comment // 

B) <!-- comment --> 

C) /* comment */ 

D) # comment 

Answer: B) <!-- comment --> 

 

22. What is the correct HTML tag for inserting a 

background image? 

A) <body background="image.jpg"> 

B) <background img="image.jpg"> 

C) <img background="image.jpg"> 

D) <bg image="image.jpg"> 

Answer: A) <body background="image.jpg"> 

 

23. Which attribute is used to open a link in a 

new tab/window? 

A) open="new" 

B) target="_blank" 

C) window="new" 

D) target="newtab" 

Answer: B) target="_blank" 

 

24. Which input type defines a slider control? 

A) slider 

B) range 

C) scroll 

D) slide 

Answer: B) range 

 

25. What is the purpose of the <fieldset> tag in 

a form? 
A) To submit the form 

B) To draw a box around grouped elements 

C) To add validation 

D) To make field editable 

Answer: B) To draw a box around grouped 

elements 

 

26. What is the correct way to create a text area 

in HTML? 

A) <input type="textarea"> 

B) <textarea> 

C) <input textarea> 

D) <textbox> 

Answer: B) <textarea> 

 

27. What is the default value of the position 

property in HTML/CSS? 
A) fixed 

B) relative 

C) static 

D) absolute 

Answer: C) static 

 

28. Which HTML5 tag is used to define 

navigation links? 

A) <navigation> 

B) <nav> 

C) <link> 

D) <navigate> 

Answer: B) <nav> 
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29. Which HTML tag is used to define the footer 

of a document or section? 

A) <bottom> 

B) <footer> 

C) <foot> 

D) <section-footer> 

Answer: B) <footer> 

 

30. Which tag is used to embed a video in 

HTML5? 

A) <media> 

B) <video> 

C) <movie> 

D) <embed> 

Answer: B) <video> 

31. What does CSS stand for? 
A) Computer Style Sheets 

B) Cascading Style Sheets 

C) Colorful Style Sheets 

D) Creative Style Sheets 

Answer: B) Cascading Style Sheets 

 

32. Which HTML tag is used to define an 

internal CSS? 

A) <css> 

B) <script> 

C) <style> 

D) <link> 

Answer: C) <style> 

 

33. What is the correct HTML element for 

inserting an external CSS file? 

A) <style src="style.css"> 

B) <stylesheet>style.css</stylesheet> 

C) <link rel="stylesheet" 
href="style.css"> 

D) <css src="style.css"> 

Answer: C) <link rel="stylesheet" 
href="style.css"> 

 

34. Where in an HTML document is the correct 

place to refer to an external style sheet? 
A) At the end of the document 

B) Inside the <body> section 

C) Inside the <head> section 
D) Anywhere 

Answer: C) Inside the <head> section 

 

35. Which is the correct CSS syntax? 

A) {body:color=black;} 

B) body:color=black; 

C) body {color: black;} 

D) {body;color:black;} 

Answer: C) body {color: black;} 

 

36. Which property is used to change the 

background color? 

A) color 

B) bgcolor 

C) background-color 

D) background 

Answer: C) background-color 

 

37. How do you add a background image in 

CSS? 

A) background-image: url("image.jpg"); 

B) bg-image: "image.jpg"; 

C) image: background("image.jpg"); 

D) background: image("image.jpg"); 

Answer: A) background-image: 
url("image.jpg"); 

 

38. Which CSS property is used to change the 

text color of an element? 
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A) fgcolor 

B) text-color 

C) color 

D) font-color 

Answer: C) color 

 

39. Which CSS property controls the text size? 

A) font-style 

B) text-size 

C) font-size 

D) size 

Answer: C) font-size 

 

40. How do you make text bold in CSS? 

A) font-style: bold; 

B) text-style: bold; 

C) font-weight: bold; 

D) font: bold; 

Answer: C) font-weight: bold; 

 

41. How do you center text in CSS? 

A) align: center; 

B) text-align: center; 

C) text: center; 

D) font-align: center; 

Answer: B) text-align: center; 

 

42. How do you select an element with id 

"demo"? 

A) #demo 

B) .demo 

C) demo 

D) *demo 

Answer: A) #demo 

 

43. How do you select elements with class name 

"menu"? 

A) #menu 

B) .menu 

C) *menu 

D) menu 

Answer: B) .menu 

 

44. Which unit is NOT a valid CSS length unit? 

A) em 

B) px 

C) pt 

D) inch 

Answer: D) inch 

 

45. What is the default value of the position 

property? 
A) absolute 

B) relative 

C) fixed 

D) static 

Answer: D) static 

 

46. Which property is used to change the font of 

text? 

A) font-style 

B) font-weight 

C) font-family 

D) text-style 

Answer: C) font-family 

 

47. What does z-index in CSS control? 

A) Zoom level 

B) Vertical alignment 

C) Stacking order 

D) Opacity 

Answer: C) Stacking order 
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48. Which property sets the spacing between 

letters? 

A) letter-spacing 

B) text-spacing 

C) word-spacing 

D) line-spacing 

Answer: A) letter-spacing 

 

49. Which CSS property is used to create space 

between elements' borders? 

A) margin 

B) padding 

C) border-spacing 

D) space 

Answer: A) margin 

 

50. Which CSS property adds space inside the 

border of an element? 

A) margin 

B) padding 

C) spacing 

D) gap 

Answer: B) padding 

 

51. What is the value to make a class hidden? 

A) display: hidden; 

B) visibility: none; 

C) display: none; 

D) visible: false; 

Answer: C) display: none; 

 

52. Which is the correct way to apply multiple 

styles to one element? 

A) style="color: red; font-size: 14px;" 

B) style="color=red font-size=14px" 

C) style="color:red; font-size=14px" 

D) style="color red, font-size 14" 

Answer: A) style="color: red; font-size: 
14px;" 

 

53. Which property controls how content is 

overflowed? 

A) overflow 

B) float 

C) display 

D) visible 

Answer: A) overflow 

 

54. Which property is used to make elements sit 

next to each other horizontally? 

A) inline-block 

B) position: absolute 

C) float 

D) align: side 

Answer: C) float 

 

55. How do you apply a style to all <p> elements 

inside <div>? 

A) div + p 

B) div.p 

C) div > p 

D) div p 

Answer: D) div p 

 

56. How do you make a list horizontal in CSS? 

A) list-style: inline; 

B) display: inline; 

C) display: flex; 

D) list-type: row; 

Answer: C) display: flex; 
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57. What does the !important declaration do in 

CSS? 
A) Removes the rule 

B) Makes the style optional 

C) Overrides all other declarations 

D) Applies style to all elements 

Answer: C) Overrides all other declarations 

 

58. Which property defines the shadow of a box? 

A) shadow 

B) box-shadow 

C) border-shadow 

D) text-shadow 

Answer: B) box-shadow 

 

59. What is the correct syntax for a media 

query? 

A) @media screen and (max-width: 600px) 

B) @media(max-width: 600px) 

C) media screen: max-width 600px 

D) query screen and max-width: 600px 

Answer: A) @media screen and (max-width: 
600px) 

 

60. Which property changes the cursor on 

hover? 

A) mouse-pointer 

B) cursor 

C) pointer-style 

D) hover-cursor 

Answer: B) cursor 

61. Photoshop is developed by which company? 
A) Corel 

B) Adobe 

C) Microsoft 

D) Apple 

Answer: B) Adobe 

 

62. The default file format of Photoshop is: 
A) .jpg 

B) .gif 

C) .psd 

D) .png 

Answer: C) .psd 

 

63. Which tool is used to make freehand 

selections? 
A) Magic Wand Tool 

B) Rectangular Marquee Tool 

C) Polygonal Lasso Tool 

D) Lasso Tool 

Answer: D) Lasso Tool 

 

64. Which shortcut key is used to copy in 

Photoshop? 
A) Ctrl + V 

B) Ctrl + Z 

C) Ctrl + C 

D) Ctrl + X 

Answer: C) Ctrl + C 

 

65. Which panel shows layers, channels, and 

paths? 
A) History Panel 

B) Info Panel 

C) Layers Panel 

D) Tools Panel 

Answer: C) Layers Panel 

 

66. What is the function of the Magic Wand 

Tool? 
A) Paints soft brush strokes 

B) Selects similarly colored areas 

C) Moves selected areas 

D) Erases part of an image 

Answer: B) Selects similarly colored areas 
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67. What does the shortcut key Ctrl + T do in 

Photoshop? 
A) Transforms the selected object 

B) Toggles tools 

C) Crops the image 

D) Opens a new tab 

Answer: A) Transforms the selected object 

 

68. Which key is used to constrain proportions 

while resizing? 
A) Alt 

B) Shift 

C) Ctrl 

D) Tab 

Answer: B) Shift 

 

69. Which tool is used to remove blemishes and 

imperfections? 
A) Brush Tool 

B) Eraser Tool 

C) Clone Stamp Tool 

D) Spot Healing Brush Tool 

Answer: D) Spot Healing Brush Tool 

 

70. Which option is used to change image size? 
A) Image > Rotate 

B) Edit > Resize 

C) Image > Image Size 

D) Layer > New 

Answer: C) Image > Image Size 

 

71. Which is a non-destructive way to apply 

filters? 
A) Directly apply filters 

B) Use a new layer 

C) Use Smart Filters 

D) Use Eraser Tool 

Answer: C) Use Smart Filters 

 

72. What does PSD stand for? 
A) Portable Standard Document 

B) Photoshop Design 

C) Photoshop Document 

D) Picture Style Design 

Answer: C) Photoshop Document 

 

73. Which tool allows you to type text in 

Photoshop? 
A) Pen Tool 

B) Brush Tool 

C) Text Tool 

D) Lasso Tool 

Answer: C) Text Tool 

 

74. Which color mode is used for printing? 
A) RGB 

B) CMYK 

C) Indexed 

D) Grayscale 

Answer: B) CMYK 

 

75. What is the shortcut to undo the last action? 
A) Ctrl + Y 

B) Ctrl + Z 

C) Ctrl + U 

D) Ctrl + A 

Answer: B) Ctrl + Z 

 

76. The Gradient Tool is used to: 
A) Create patterns 

B) Blend colors 

C) Select areas 
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D) Crop image 

Answer: B) Blend colors 

 

77. What is the function of the Crop Tool? 
A) Resize image 

B) Add layers 

C) Select text 

D) Trim or cut out part of the image 

Answer: D) Trim or cut out part of the image 

 

78. The Clone Stamp Tool is used to: 
A) Copy selections 

B) Remove red-eye 

C) Paint colors 

D) Duplicate parts of an image 

Answer: D) Duplicate parts of an image 

 

79. To zoom in on an image, you can press: 
A) Ctrl + Z 

B) Ctrl + + 

C) Ctrl + X 

D) Ctrl + V 

Answer: B) Ctrl + + 

 

80. Which format is best for web graphics with 

transparency? 
A) JPG 

B) BMP 

C) PNG 

D) TIFF 

Answer: C) PNG 

 

81. The History Panel is used to: 
A) View color info 

B) Record layers 

C) Undo or redo multiple steps 

D) Change file format 

Answer: C) Undo or redo multiple steps 

 

82. Which tool is used to move an object? 
A) Zoom Tool 

B) Move Tool 

C) Marquee Tool 

D) Slice Tool 

Answer: B) Move Tool 

 

83. What does the Eyedropper Tool do? 
A) Zoom into image 

B) Copy shape 

C) Selects color from image 

D) Apply effects 

Answer: C) Selects color from image 

 

84. How do you hide/show rulers? 
A) Ctrl + H 

B) Ctrl + R 

C) Ctrl + T 

D) Ctrl + U 

Answer: B) Ctrl + R 

 

85. Which filter is used for sharpening an image? 
A) Blur 

B) Pixelate 

C) Sharpen 

D) Noise 

Answer: C) Sharpen 

 

86. In Photoshop, layers are: 
A) Color channels 

B) Image size options 

C) Transparent sheets stacked on top of each other 

D) Filters 
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Answer: C) Transparent sheets stacked on top of 

each other 

 

87. Which tool is used to draw curves and 

custom shapes? 
A) Brush Tool 

B) Lasso Tool 

C) Pen Tool 

D) Polygon Tool 

Answer: C) Pen Tool 

 

88. How do you deselect a selected area? 
A) Ctrl + D 

B) Ctrl + X 

C) Ctrl + C 

D) Ctrl + F 

Answer: A) Ctrl + D 

 

89. Which of the following is a raster graphics 

editor? 
A) Adobe Illustrator 

B) CorelDraw 

C) Adobe Photoshop 

D) InDesign 

Answer: C) Adobe Photoshop 

 

90. Which panel in Photoshop lets you manage 

color adjustments like brightness and contrast? 
A) Adjustments Panel 

B) Layers Panel 

C) Paths Panel 

D) History Panel 

Answer: A) Adjustments Panel 

91. CorelDRAW is developed by: 
A) Adobe 

B) Corel Corporation 

C) Microsoft 

D) Autodesk 

Answer: B) Corel Corporation 

 

92. The default file extension for CorelDRAW is: 
A) .cdr 

B) .corel 

C) .draw 

D) .cdw 

Answer: A) .cdr 

 

93. CorelDRAW is primarily used for: 
A) Video editing 

B) Spreadsheet calculations 

C) Vector graphic design 

D) 3D modeling 

Answer: C) Vector graphic design 

 

94. Which tool is used to draw straight lines in 

CorelDRAW? 
A) Shape Tool 

B) Freehand Tool 

C) Rectangle Tool 

D) Zoom Tool 

Answer: B) Freehand Tool 

 

95. Shortcut key to group objects in CorelDRAW 

is: 
A) Ctrl + D 

B) Ctrl + G 

C) Ctrl + C 

D) Ctrl + L 

Answer: B) Ctrl + G 

 

96. Which tool is used to modify the shape of 

objects? 
A) Shape Tool 

B) Zoom Tool 
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C) Pick Tool 

D) Outline Tool 

Answer: A) Shape Tool 

 

97. Which tool is used to select and move 

objects? 
A) Freehand Tool 

B) Shape Tool 

C) Pick Tool 

D) Text Tool 

Answer: C) Pick Tool 

 

98. Which of the following is a vector file 

format? 
A) .jpg 

B) .cdr 

C) .bmp 

D) .gif 

Answer: B) .cdr 

 

99. What does the shortcut key F4 do in 

CorelDRAW? 
A) Opens new document 

B) Imports image 

C) Zoom to all objects 

D) Saves the document 

Answer: C) Zoom to all objects 

 

101. The default page size in CorelDRAW is: 
A) A4 

B) Letter 

C) Legal 

D) Custom 

Answer: A) A4 

 

102. Shortcut key to ungroup objects is: 
A) Ctrl + U 

B) Ctrl + Shift + G 

C) Ctrl + Shift + U 

D) Ctrl + Shift + L 

Answer: A) Ctrl + U 

 

103. CorelDRAW workspace includes: 
A) Property bar 

B) Toolbox 

C) Menu bar 

D) All of the above 

Answer: D) All of the above 

 

104. Which tool is used to fill objects with color 

in CorelDRAW? 
A) Interactive Fill Tool 

B) Color Picker Tool 

C) Smart Fill Tool 

D) Bucket Tool 

Answer: C) Smart Fill Tool 

 

105. The shortcut key for duplicating an object 

is: 
A) Ctrl + C 

B) Ctrl + D 

C) Ctrl + G 

D) Ctrl + X 

Answer: B) Ctrl + D 

 

106. CorelDRAW is mainly used by: 
A) Architects 

B) Programmers 

C) Graphic designers 

D) Engineers 

Answer: C) Graphic designers 

 

107. What does the shortcut key Ctrl + Q do? 
A) Converts object to curves 
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B) Opens the file 

C) Closes application 

D) Opens the color palette 

Answer: A) Converts object to curves 

 

108. What does the Zoom Tool do? 
A) Resize object 

B) Resize page 

C) Magnify or reduce view 

D) Crop image 

Answer: C) Magnify or reduce view 

 

109. CorelDRAW allows working with how 

many pages in one document? 
A) One 

B) Ten 

C) Unlimited 

D) Only front and back 

Answer: C) Unlimited 

 

110. Shortcut to open the Object Manager 

docker is: 
A) Ctrl + F3 

B) Ctrl + F5 

C) Ctrl + F7 

D) Ctrl + F10 

Answer: C) Ctrl + F7 

 

111. Which tool is used to make curved lines? 
A) Freehand Tool 

B) Bezier Tool 

C) Shape Tool 

D) Rectangle Tool 

Answer: B) Bezier Tool 

 

112. Which tool is used to remove part of a 

drawing? 

A) Knife Tool 

B) Crop Tool 

C) Eraser Tool 

D) Break Tool 

Answer: A) Knife Tool 

 

113. What is the use of the Eyedropper Tool in 

CorelDRAW? 
A) To magnify object 

B) To sample color from one object to another 

C) To crop image 

D) To duplicate shape 

Answer: B) To sample color from one object to 

another 

 

114. To fit selected objects to page, use: 
A) F3 

B) Ctrl + F9 

C) Shift + F4 

D) Alt + F4 

Answer: C) Shift + F4 

 

115. Which tool is used to type and format text? 
A) Text Tool 

B) Pen Tool 

C) Artistic Tool 

D) Script Tool 

Answer: A) Text Tool 

 

116. Which is NOT a valid file format supported 

by CorelDRAW? 
A) .cdr 

B) .ai 

C) .psd 

D) .xls 

Answer: D) .xls 
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117. Which menu provides the option to align 

objects? 
A) Layout 

B) Tools 

C) Arrange 

D) Effects 

Answer: C) Arrange 

 

118. Shortcut to save a CorelDRAW file is: 
A) Ctrl + W 

B) Ctrl + S 

C) Ctrl + P 

D) Ctrl + O 

Answer: B) Ctrl + S 

 

119. Which tool allows scaling, rotating, skewing 

and mirroring? 
A) Shape Tool 

B) Transform Tool 

C) Freehand Tool 

D) Transparency Tool 

Answer: B) Transform Tool 

 

120. What is PowerClip in CorelDRAW? 
A) A printing option 

B) An animation tool 

C) Placing one object inside another 

D) Zooming technique 

Answer: C) Placing one object inside another 

 

121. Which version of CorelDRAW first 

supported multi-page view? 
A) X3 

B) X4 

C) X5 

D) 2020 

Answer: D) 2020 

132. What does GIF stand for? 
A) Graphic Image Format 

B) Graphics Interchange Format 

C) General Image File 

D) Graphic Interface Format 

Answer: B) Graphics Interchange Format 

 

133. What type of image format is GIF? 
A) Raster 

B) Vector 

C) Audio 

D) 3D 

Answer: A) Raster 

 

134. GIF animation is mainly used for: 
A) Printing banners 

B) Interactive games 

C) Web-based animations 

D) Video editing 

Answer: C) Web-based animations 

 

135. Which color mode is supported by GIF 

format? 
A) RGB 

B) CMYK 

C) Indexed color 

D) Grayscale 

Answer: C) Indexed color 

 

136. GIF images support how many colors? 
A) 256 

B) 16 million 

C) 1024 

D) Unlimited 

Answer: A) 256 
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137. GIF format supports: 
A) Transparency only 

B) Animation only 

C) Both transparency and animation 

D) Sound and video 

Answer: C) Both transparency and animation 

 

138. Which software is commonly used to create 

GIF animations? 
A) MS Word 

B) Adobe Animate 

C) Excel 

D) Audacity 

Answer: B) Adobe Animate 

 

139. Which of the following software can export 

GIF animations? 
A) Adobe Photoshop 

B) CorelDRAW 

C) MS Paint 

D) WordPad 

Answer: A) Adobe Photoshop 

 

140. What is a keyframe in animation? 
A) A frame with no content 

B) A blank image 

C) The start or end frame of a transition 

D) A background image 

Answer: C) The start or end frame of a 

transition 

 

141. In GIF animation, frames are displayed in: 
A) Reverse 

B) Random 

C) Sequence 

D) Simultaneously 

Answer: C) Sequence 

 

142. Which file extension is used for animated 

GIFs? 
A) .agif 

B) .gifa 

C) .gif 

D) .ani 

Answer: C) .gif 

 

143. GIF animations are best used for: 
A) HD movies 

B) Vector logos 

C) Simple web animations 

D) Audio mixing 

Answer: C) Simple web animations 

 

144. What does frame delay refer to in GIF 

animation? 
A) Speed of computer 

B) Time between two frames 

C) Size of image 

D) Font size 

Answer: B) Time between two frames 

 

145. What is looping in GIF animation? 
A) Playing the animation once 

B) Skipping frames 

C) Repeating the animation continuously 

D) Reversing the animation 

Answer: C) Repeating the animation 

continuously 

 

146. Which of the following image formats 

supports animation? 
A) JPG 

B) PNG 

C) GIF 

D) BMP 

Answer: C) GIF 
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147. Which software is not suitable for creating 

GIF animations? 
A) Adobe Animate 

B) After Effects 

C) Adobe Photoshop 

D) Notepad 

Answer: D) Notepad 

 

148. Which tool in Photoshop is used to manage 

frame-based animations? 
A) Timeline Panel 

B) Layers Panel 

C) Info Panel 

D) History Panel 

Answer: A) Timeline Panel 

 

149. GIF animation is resolution-dependent, 

which means: 
A) Can scale without losing quality 

B) Becomes blurry when resized 

C) Automatically sharpens 

D) Edits vector paths 

Answer: B) Becomes blurry when resized 

 

150. Which file size is generally larger? 
A) GIF 

B) JPG 

C) PNG 

D) BMP 

Answer: D) BMP 

 

151. Transparency in GIF allows: 
A) Sound mixing 

B) Background removal 

C) Frame merging 

D) Shape rotation 

Answer: B) Background removal 

 

152. Can GIF support partial transparency like 

PNG? 
A) Yes 

B) No 

Answer: B) No 

 

153. How many bits per pixel does GIF use? 
A) 1 

B) 8 

C) 16 

D) 32 

Answer: B) 8 

 

154. What is the advantage of GIFs over video 

formats for web use? 
A) Better resolution 

B) Short size and simple playback 

C) Higher sound quality 

D) Supports scripting 

Answer: B) Short size and simple playback 

 

155. Which web platform is famous for using 

GIFs? 
A) LinkedIn 

B) Quora 

C) Giphy 

D) Excel 

Answer: C) Giphy 

 

156. To preview animation in Photoshop, which 

option is used? 
A) Play button in Timeline 

B) Save for Web 

C) Export As... 

D) File > Open 

Answer: A) Play button in Timeline 



  Web & Graphic Designing 

Download from: www.icstinstitute.in 
 

Institute   RAKESH MARG GHAZIABAD (9650571128)  Page 18 of 22 

 

 

157. In frame-by-frame GIF animation, each 

frame is: 
A) Automatically generated 

B) Identical 

C) Manually created 

D) Skipped 

Answer: C) Manually created 

 

158. Which export option in Photoshop is used 

for GIF animation? 
A) Save As JPG 

B) Save As PNG 

C) Save for Web (Legacy) 

D) Save as PSD 

Answer: C) Save for Web (Legacy) 

 

159. GIF animation works best for: 
A) Complex video scenes 

B) Simple motion with limited colors 

C) 3D modeling 

D) Transparent SVG images 

Answer: B) Simple motion with limited colors 

 

160. How is the frame rate of a GIF measured? 
A) Pixels per second 

B) Frames per second (FPS) 

C) Inches per frame 

D) Time per color 

Answer: B) Frames per second (FPS) 

 

161. GIF animation is mostly used in: 
A) Printed designs 

B) Web and social media 

C) Audio projects 

D) CAD software 

Answer: B) Web and social media 

162. Which tool is used to lighten areas of an 

image in Photoshop? 
A) Burn Tool 

B) Dodge Tool 

C) Sponge Tool 

D) Eraser Tool 

Answer: B) Dodge Tool 

 

163. What is the function of the Clone Stamp 

Tool in Photoshop? 
A) Apply filters 

B) Copy pixels from one part of an image to another 

C) Add gradients 

D) Resize images 

Answer: B) Copy pixels from one part of an 

image to another 

 

164. What does the shortcut Ctrl + J do in 

Photoshop? 
A) Merge layers 

B) Copy selected layer to a new layer 

C) Join two images 

D) Jump to new file 

Answer: B) Copy selected layer to a new layer 

 

165. Which format supports layers in 

Photoshop? 
A) PNG 

B) JPG 

C) PSD 

D) BMP 

Answer: C) PSD 

 

166. The tool used to blur areas of an image is: 
A) Smudge Tool 

B) Blur Tool 

C) Burn Tool 

D) Healing Brush Tool 

Answer: B) Blur Tool 
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167. What is the purpose of the History panel in 

Photoshop? 
A) Track layer changes 

B) Undo/Redo multiple actions 

C) Export projects 

D) Create new layers 

Answer: B) Undo/Redo multiple actions 

 

168. What does the Crop Tool do? 
A) Resize canvas 

B) Reduce image resolution 

C) Remove unwanted edges of an image 

D) Add color to image 

Answer: C) Remove unwanted edges of an image 

 

169. Which panel allows users to apply non-

destructive effects in Photoshop? 
A) Tools panel 

B) Adjustments panel 

C) Info panel 

D) Timeline panel 

Answer: B) Adjustments panel 

 

170. What happens when you press Ctrl + T on a 

selected object? 
A) Apply a filter 

B) Transform the object (resize, rotate, etc.) 

C) Trim the layer 

D) Toggle tools 

Answer: B) Transform the object (resize, rotate, 

etc.) 

 

171. The shortcut Ctrl + Z performs which 

action? 
A) Save 

B) Redo 

C) Undo 

D) Zoom 

Answer: C) Undo 

 

172. What is the use of the Smart Object in 

Photoshop? 
A) Reduces file size 

B) Rasterizes layers 

C) Retains image quality and allows non-destructive 

editing 

D) Adds gradients 

Answer: C) Retains image quality and allows 

non-destructive editing 

 

173. What is the difference between the Brush 

Tool and the Pencil Tool? 
A) No difference 

B) Pencil is used for text 

C) Brush has softer edges, Pencil has hard edges 

D) Brush is used only on background 

Answer: C) Brush has softer edges, Pencil has 

hard edges 

 

174. How can you apply a layer mask in 

Photoshop? 
A) Select the layer and click the ‘Add Layer Mask’ 

icon 

B) Use the Paint Bucket Tool 

C) Right-click and select Flatten Image 

D) Use the Smudge Tool 

Answer: A) Select the layer and click the ‘Add 

Layer Mask’ icon 

 

175. What does the Pen Tool do? 
A) Draws with a brush 

B) Paints over photos 

C) Creates vector paths and shapes 

D) Erases background 

Answer: C) Creates vector paths and shapes 
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176. The shortcut key to save a file in Photoshop 

is: 
A) Ctrl + A 

B) Ctrl + D 

C) Ctrl + S 

D) Ctrl + Z 

Answer: C) Ctrl + S 

 

177. Which tool helps in removing red-eye in 

photos? 
A) Spot Healing Brush Tool 

B) Clone Stamp Tool 

C) Red Eye Tool 

D) Patch Tool 

Answer: C) Red Eye Tool 

 

178. What is the difference between raster and 

vector in Photoshop? 
A) Raster uses code, vector uses pixels 

B) Raster uses pixels, vector uses mathematical 

paths 

C) Raster is text-based 

D) No difference 

Answer: B) Raster uses pixels, vector uses 

mathematical paths 

 

179. Which tool helps in correcting lens 

distortions? 
A) Liquify Tool 

B) Perspective Tool 

C) Lens Correction Filter 

D) Sharpen Tool 

Answer: C) Lens Correction Filter 

 

180. What does the Opacity setting control? 
A) Resolution 

B) Layer blending 

C) Transparency of a layer 

D) Brightness 

Answer: C) Transparency of a layer 

 

181. Photoshop’s default background color is: 
A) Blue 

B) Black 

C) White 

D) Gray 

Answer: D) Gray 

182. What is the main file extension of 

CorelDRAW files? 
A) .cdr 

B) .cdw 

C) .crl 

D) .cdd 

Answer: A) .cdr 

 

183. Which tool is used to reshape curves in 

CorelDRAW? 
A) Pick Tool 

B) Shape Tool 

C) Zoom Tool 

D) Artistic Media Tool 

Answer: B) Shape Tool 

 

184. Shortcut to align selected objects to the 

center of the page: 
A) P 

B) C 

C) E 

D) T 

Answer: A) P 

 

185. What does Ctrl + D do in CorelDRAW? 
A) Delete object 

B) Duplicate object 

C) Deselect object 
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D) Draw ellipse 

Answer: B) Duplicate object 

 

186. The Bezier Tool is used for: 
A) Drawing rectangles 

B) Creating freehand curves 

C) Drawing complex and precise curves 

D) Applying gradients 

Answer: C) Drawing complex and precise curves 

 

187. CorelDRAW works on which type of 

graphics? 
A) Raster 

B) Vector 

C) Bitmap 

D) 3D 

Answer: B) Vector 

 

188. What does the Interactive Blend Tool do? 
A) Duplicates objects 

B) Merges colors 

C) Creates transitions between two objects 

D) Removes background 

Answer: C) Creates transitions between two 

objects 

 

189. Which tool is used to combine objects in 

CorelDRAW? 
A) Arrange → Group 

B) Weld Tool 

C) Merge Tool 

D) Smudge Tool 

Answer: B) Weld Tool 

 

190. Shortcut key to import a file in 

CorelDRAW: 
A) Ctrl + I 

B) Ctrl + E 

C) Ctrl + O 

D) Ctrl + N 

Answer: A) Ctrl + I 

 

191. The Pick Tool is used to: 
A) Fill objects 

B) Select and transform objects 

C) Rotate canvas 

D) Add gradients 

Answer: B) Select and transform objects 

 

192. What does the Envelope Tool do? 
A) Wraps an object inside another 

B) Changes shape of an object by dragging its 

nodes 

C) Creates circular shapes 

D) Sends object to back 

Answer: B) Changes shape of an object by 

dragging its nodes 

 

193. CorelDRAW allows working with how 

many layers? 
A) Only 1 

B) 5 

C) Unlimited 

D) 10 

Answer: C) Unlimited 

 

194. What does Ctrl + Q do in CorelDRAW? 
A) Quit CorelDRAW 

B) Convert to curves 

C) Quick save 

D) Open new file 

Answer: B) Convert to curves 
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195. Which tool is used to create a star in 

CorelDRAW? 
A) Polygon Tool 

B) Star Tool 

C) Shape Tool 

D) Ellipse Tool 

Answer: B) Star Tool 

 

196. To zoom into a specific area, you use: 
A) Freehand Tool 

B) Shape Tool 

C) Zoom Tool 

D) Pick Tool 

Answer: C) Zoom Tool 

 

197. What does the Transparency Tool do? 
A) Blurs objects 

B) Makes parts of an object transparent 

C) Adds borders 

D) Removes fill 

Answer: B) Makes parts of an object transparent 

 

198. Shortcut key to export in CorelDRAW is: 
A) Ctrl + S 

B) Ctrl + X 

C) Ctrl + E 

D) Ctrl + D 

Answer: C) Ctrl + E 

 

199. What is PowerClip in CorelDRAW used 

for? 
A) Removing colors 

B) Grouping objects 

C) Placing one object inside another 

D) Clipping text 

Answer: C) Placing one object inside another 

 

200. Which menu provides tools for object 

alignment? 
A) File 

B) Edit 

C) Arrange 

D) View 

Answer: C) Arrange 

 


